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Product Configuration and Description
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Integration Schematics: Sound and Voice Analytics – Milestone VMS1
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Figure 1 : Architecture

ISD-1000iO: External sound receiving hardware device with microphone that recognizes abnormal sound and voice. 

ISD Server : Interworking program that transmits event data received through ISD-1000iO device to Milestone VMS.

Kserver : A voice recognition server program for classifying voice that received through the ISD-1000iO device.

FileZila : FTP server program to save the event sounds received through the ISD-1000iO device.



ISD-1000iO Voice recognition product configuration and description -11

◆ Product Components

ISD-1000iO Device
Lower cover

Direct Current Power Unit (5V DC )

※ However, only DC equipment is 
provided.

Angle adjusting/ Mount bracket Etc
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전면 후면
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◆ Equipment Description

VESA Mount hole

① Microphone for detecting abnormal sound
② LED for status indication (blue, green, red)
③ Waterproof flexible Connector

① 5V IN Power Terminal

② RJ45 terminal

Front view Back Bottom
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Explanation Detailed image

◆ Status LED Description

Power
"Always on" after system boot (right)

"Flashes" once per second during normal operation of 
device (center)

"Turned on" until the device reboot (takes 3-5min)
"Flashes" when sound source is detected (left)

※ Each LED direction is based on the front of the equipment.
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Step 1. Milestone-related Program Installation

Step 2. Adding Camera to Milestone

Step 3. Neurolytics plugin Settings in MIP

Step 4. ISD Server Settings

Step 5. Adding MIP driver to Milestone

Step 6. Adding Metadata (Camera to MIP driver)

Step 7. SA Event and Alarm Settings

Step 8. CCTV Footage View grid Settings

Pre-installation Requirement

The detailed Milestone VMS user manual found in the following link

https://doc.milestonesys.com/latest/en-US/portal/htm/chapter-page-sc-user-manual.htm?TocPath=XProtect%20Smart%20Client%7CXProtect%20Smart
%20Client%20user%20manual%7C_____0

https://doc.milestonesys.com/sc/pdf/2020r3/en-US/MilestoneXProtectSmartClient_UserManual_en-US.pdf
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https://doc.milestonesys.com/latest/en-US/portal/htm/chapter-page-sc-user-manual.htm?TocPath=XProtect%20Smart%20Client%7CXProtect%20Smart%20Client%20user%20manual%7C_____0
https://doc.milestonesys.com/sc/pdf/2020r3/en-US/MilestoneXProtectSmartClient_UserManual_en-US.pdf


Milestone – SA Plugin System; Installer & License files

Make sure that all installer and relevant license files are received before starting the installation process
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Download and install Visual C++ Redistributable Packages 
https://www.microsoft.com/en-us/download/confirmation.aspx?id=14632 (2010)
https://www.microsoft.com/en-us/download/confirmation.aspx?id=48145 (2015)

https://www.microsoft.com/en-us/download/confirmation.aspx?id=14632
https://www.microsoft.com/en-us/download/confirmation.aspx?id=48145


Step 1. Milestone-related Program Installation

Optional for demo use
(if there are no real camera)

Locate Milestone License

Choose Single computer

Milestone License 
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Step 1. Milestone-related Program Installation

Uncheck and continue

Uncheck and continue
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Step 1. Milestone-related Program Installation

Enter user name/password 
and continue
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Step 1. Milestone-related Program Installation

Run the “Smart client” & connect Make sure all the Milestone sever programs 
are running in the background.

- It can be verified by “desktop tray” icon as 
shown below.
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Step 2. Adding Camera to Milestone

Right click

1 2

3
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Step 2. Adding Camera to Milestone

uncheck
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Step 2. Adding Camera to Milestone
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Step 2. Adding Camera to Milestone
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Step 3. Neurolytics plugin Settings in MIP
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Step 3. Neurolytics plugin Settings in MIP

1. Run MIPSDK_Installer provided by Milestone.

2. Copy plugin folder named “Neurolytics” and paste the folder inside the path C:\Program Files\Milestone\MIPPlugins

Copy and paste; 
folder to folder

3. Enable Neurolytics plugin by opening “Plugin Overview” and

choosing Neurolytics option in “MIP SDK Tray Manager”

program as shown in the picture: 1

2

1
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Step 3. Neurolytics plugin Settings in MIP

4. Unselect all plugin files by “Clear all”

5. Enable “Neurolytics” plugins by opening “Plugin Overview” and select in Plugin Overview Manager as shown in

the picture. Press “Save”.
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Step 3. Neurolytics plugin Settings in MIP

 To verify the Neurolytics plugin that installed was successful or not, open XProtect Smart Client 

program, and go to “About” option and click on. 

 It was successful if a pop-up window show as below.
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A. ISDserver.exe Connection

1) Execute ISDserver.exe in the ISD folder.

2) Milestone VMS is installed in the Server address of the 
“Connect to server” screen. Enter the IP address of the server.

※ When using Milestone and ISD together on a local server, 
Enter http://localhost/

4) Enter your Milestone account information in User Name and 
Password.

※ Milestone related information is changed according to the setting 
value when installing Milestone.

5) Click “Connect” button to connect to ISDserver.

◆ ISDserver is an interworking program that transmits events to Milestone VMS.

Program image Explanation
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Step 4. ISD Server Settings -1

http://localhost/


B. ISDserver.exe settings

1) Click “Choose Folder” to select a folder to extract 

camera information from.

2) Click “Export” button to extract information of all 

cameras connected to Milestone VMS.

※ After executing the ISDserver program, 

“Caminfo.txt” file is created in the selected folder. 

Information of all cameras connected to Milestone VMS 

is entered in the file.

3) Click the “Start server” button to connect to the 

server.

※ After clicking the button, “Waiting… ” status and ready 

to link.)

◆ ISDserver is an interworking program that transmits events to Milestone VMS.

Program image Explanation
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Step 5. Adding MIP driver to Milestone

1
Right click

2

3

4
5
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7

8

9

uncheck

check

Notes: MIP driver can only be added when the ISD server is running
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Step 5. Adding MIP driver to Milestone
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Step 6. Adding Metadata (Camera to MIP driver)
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click

 Note that you have to associate metadata channels with  

cameras and MIP in a one-to-one mapping manner.



Step 7. SA Event and Alarm Settings
Right click

Right click
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Step 7. SA Event and Alarm Settings

4

5

6
7

8

10

9

28

click



Step 8. CCTV Footage View grid Settings
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Step 8. CCTV Footage View grid Settings
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9.1 Drag and drop

30



2

Device HW Installation
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1. Power Supply

This unit uses a 5V DC power adapter or

For POE equipment, supply power through POE.

2. Equipment connection

After powering on, connect the device to the router.

Run the supplied SEN2000-ETHERNET.exe.

SEN2000-ETHERNET: Tool to set network related setting, interworking 

information and threshold (volume bar)

(See back page)

2

Explanation Detailed image

IP Router Test PC

LAN Cable
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① Connect the angle source equipment and angle 
bracket.

* Screws required for bracket mounting are included.

② Connecting blocks and RJ45 when installing 

waterproof flexible. pass all DC and UTP lines first.

Device HW Installation -22

Explanation Detailed image

After fastening the bracket
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③ Waterproof flexible after connecting DC power and 
RJ45 (UTP cable) Replace the bottom cover with the 
connector attached.

④ Attach abnormal sound equipment to the wall.

※ Notes on Installation

 There should be no obstacles near the equipment for smooth sound source detection.

 It is recommended to avoid installation where frequent noises occur.

 It is recommended to install at least at the height of 2M because there is a risk of damage.

Device HW Installation -32

Explanation Detailed image

Field installation example)
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Device HW settings
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1. Equipment IP Settings

1) Click the 'Device Find' button to search for the connected device.

2) Find the IP of the device you want to set in the device list and 

double click it.

3) After checking 'Static' item, input the IP and network setting value 

of the device to be set in Client IP, Subnet mask, Gateway.

(You must check the Static radio button to activate each equipment.)

Device HW settings3

Explanation Detailed image

◆ ISD Ethernet is a tool program used to set up the equipment IP address.

Example) If the equipment is 
set as follows

 Device IP: 192.168.21.162
 Subnet mask: 255.255.240.0
 Gateway : 192.168.17.1

2
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2. FTP Server setting

Enter FTP Server IP and PORT where detected sound will be 

uploaded. (By default, PORT uses 24.)

※ The detected event source is uploaded to the FTP server.

3. UDP Server Setting

Enter the Server IP and Port to receive UDP messages.

(In case of linking with Milestone, PORT is 1308 and Serverip is the 

server IP where “ISD server” program is installed.)
※ When interlocking with VMS, etc., interlock with UDP packet.

4. VOICE Server setting

Enter the Server IP and PORT where KServer (voice recognition server) 
will be installed.

(Default port is 5050 and if changed, KSERVER program also

You need to change the setting.)

※ It analyzes / extracts the words included in the sound source 
stream input through the device.

Device HW settings3

Explanation Detailed image

◆ Ethernet tool  
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Server PC IP

Camera ID that 
exported from ISDserver. 
- Refer page 23

Example:

 FTP Server PORT: 24
 Udp Server PORT: 7085
 Voice server PORT : 5050



5. Camera ID

Enter the camera information to be linked. Refer to Slide #23

(You can check the camera information in “Caminfo.txt” that 

“Exported” from ISDServer.exe.)

6. PTZ Initial number setting

PTZ Set the initial number.

7. Location setting

Specify the equipment installation location.

8. Par

interlocking-formatted Separator Set (default: _ )

9. Mode
Sets UDP packet interlocking format (default: 0)

10. Device Alive Time

Keep alive Set the interval for sending messages.
(When it is set as 0, it is not transmitted. When it is linked 

with Milestone, it is set as 0.)

Device HW settings3

Explanation Detailed image

◆ Ethernet tool  
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11. Threshold Setting

Click “Device and Mic Settings” and “Connect” menu. 

 Mic input: current environmental noise dB

 Threshold: set value, should be higher than Mic Input

 Gain: Microphone Gain Value

This function sets the dB value for detecting sound sources.

The more you set it to the right, the higher the volume of the 
sound source you want to detect.

Click the 'Info Update' button to apply the changes before 

setting the threshold.

At this time, the device will reboot once.

Device HW settings3

Explanation Detailed image

◆ Ethernet Tool  
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12. class setting

① Class Mode

- Lite : ISD-1000M1 Ver
- Full : ISD-1000iO Voice recognition Ver

② Target list

Specify which event number to send the result to the 
VMS when classified as a class.
(No event sent when set to 00)

4. After clicking the ‘Light’ button, change the “Target List” as 

follows using “Edit” menu”

0: Noise → 00
1: Scream → 05

Remove other events or numbers by “Delete” menu

Device HW settings3

Explanation Detailed image

◆ Ethernet tool  
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5. After editing with ‘Edit’ 

button be sure to click the 

"Update" button
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13. Info Update

After class set, press “Info Update”

 The device start reboot

 Reboot takes roughly 5min

Device HW settings3

Explanation Detailed image

◆ Ethernet tool  

1
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4

4. Sound & Voice Analytics Server Program Setting

1 KSERVER Settings

2 FTP Server Settings
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◆ KSERVER is a voice recognition server program that has the function of extracting the words contained in the sound source 
received through the ISD-1000iO voice recognition equipment. 

KSERVER Settings-1

A. KSERVER License

1)  When run “K server program”, it will ask license

2) Please send the “info” to IVS to deliver the license 1, 2,

3) After plugin license it will show “Good” and click “ok”

※ This license part, generate different “info” whenever you turn 
on. To keep in same, it is recommended to disable all Ethernet 
connections except just 1, in “device manager” menu.

Explanation Program image
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◆ KSERVER is a voice recognition server program that has the function of extracting the words contained in the sound source 
received through the ISD-1000iO voice recognition equipment. 

KSERVER Settings-2

B. KSERVER setting

1)  ③ Specify the port to receive the sound stream from the item.. 

(When changing from 5050 set as the default port, click Save Setting to apply.)

2) Start button (item 1): Receives sound stream from abnormal 
sound source equipment and starts word extraction.

3) Stop button (item 2): Receives sound stream from abnormal sound 
source equipment and stops word extraction.

※ By default, it automatically start the program without clicking 
the Start button and receives a sound streams from the device.

Explanation Program image

1 2 3 4
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1. FileZila FTP Server installation

1) Double-click FileZila_Server.exe to run it.

2) Click the Next button to proceed with the installation as shown.

◆ Save detected event sources on FTP server

FTP Server Settings-1

Explanation Program image
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1. FTP SERVER settings

1) Run Connect to Server on the File tab, enter the following and click 

the Connect button.

 HOST: 127.0.0.1

 PORT: 14147

 PASSWORD: 1234

◆ Save detected event sources on FTP server

FTP Server Settings-2

Explanation Program image

1

Enter 1234
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2. FTP port setting

1) Enter the Setting tab of the Edit tab and enter as follows. 

General settings – Listen on these ports: 24

2) After completing the input, click the OK button on the bottom left.

◆ Save detected event sources on FTP server

FTP Server Settings-3

Explanation Program image
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3. User settings

1) Click “User” in the “Edit” tab and 

proceed as follows: 

2) Add an account using the “Add” 

button.

3) Create ID “ivs_file_server “ (no 

space) and press “Ok”

4) In “Account settings”, check 

password and enter “1234”

5) After completing ID and PW input

in step 4 do not click the “OK” 

button on the bottom left (it is final 

step) but move to next step because 

step 6,7,8,9 yet to complete.

6)  Click “Shared folder”

◆ Save detected event sources on FTP server

FTP Server Settings-4

Explanation Program image
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Enter 1234
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7) Shared folder – Specify the file path to save using 

the “Add” button on the bottom left.

8) Then click on the created path to specify the 

permissions. 

Check all 

 “ Read, Write, Delete, append, Create Delete, List, + 

Subdirs” 

9) After completing the input, click the OK button on 

the bottom left to complete the Filezila setup.

◆ Save detected event sources on FTP server

FTP Server Settings-5

Explanation Program image
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4. Firewall settings

Run Windows Defender Firewall with Advanced Security.

1) Run in 'Control Panel'-> Windows Defender Firewall-> “Advanced 

Settings” on the left

2) Right-click “Inbound Rules” and click “New Rule”. Not the one 

shown at far right

3) Check the “Custom option” and click the "Next" button.

4) Check “All programs” options and click the "Next" button.

5) Click 'Next' until the 'Name' item appears and enter 'IVS_FTP' in 

the 'Name' field of the Name tab.

◆ Save detected event sources on FTP server

FTP Server Settings-6

Explanation Program image

50

1

2

3

Right click

4



6) Click 'Finish' to complete the rule creation.

When the setting is completed as above, the sound source is uploaded to 

the path.

◆ Save detected event sources on FTP server

FTP Server Settings-7

Explanation Program image
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Abnormal Sound Event & Event Log Testing in Milestone 
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Event confirmation

When an event (“Help” or 

“Help me” or “Scream” is 

normally received, an event 

popup is displayed along with 

the event type as shown in the 

picture

Checking the “Event” in Milestone

프로그램 이미지 설명Program image
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The event log can be 

checked in the “Alarm 

Manager” tab as shown 

in the picture.

VAEvent = Video analytics 

Event

ISDEvent = Intelligent 

Sound Detector Event

Checking the “Event Log” in Milestone
Program image

5

54



6

Summary
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1. Run FileZilla program

- Login if need

2. Run ISD program

- Login server

- Press “Start server” status

should be “Waiting”

3. Run Kserver program

4. Run Milestone Client (No need to open 

Management server)

5. No need to run Ethernet program because 

HW reset is done by 1 time. 

Run Ethernet when need to change 

HW settings such as IP address, etc.

Run all the program after closing all the program. All program should not be closed but can be minimized. 

Summary

프로그램 이미지 설명Program image
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Thank you
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